
Building a Team  
and Working from 

Different Localities
In this chapter we will cover:

 f Working with editors and proofreaders—a checklist

 f Working with designers—spread your workload and learn to assemble from  
different elements

 f Sending out, uploading, and publishing iWork documents—ways to stay connected

Introduction
A large, continuing project in iWork, such as publishing a magazine, a newsletter, or a 
newspaper, generally involves a number of co-workers. You could be working with writers, 
designers, editors, photographers, and printers.

This chapter provides recipes on how to organize teamwork, particularly with editors  
and designers.

Working with editors and proofreaders—a 
checklist

Editors check the overall content of a document. For example, does it make sense? Is 
it interesting? Is it well-written? Is it easy to understand? Is it suitable for the intended 
readership? Editors make changes in style and wording. They write headings, subheadings, 
callouts, and captions for images. Sometimes they oversee the whole project.
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Proofreaders check spelling and grammar, correct mistakes and misprints, and compare 
original documents with how they look in the project before it goes public. Theirs is a more 
technical task.

These are separate jobs, but they often overlap. An editor may correct mistakes and typos and 
a proofreader may suggest changes in style or presentation.

How to do it...
iWork has a number of powerful tools for editors and proofreaders—spellcheck, tracking, 
comments, and find—which you can use either if you are a proofreader/editor or if you are 
proofing and editing your own documents. This recipe describes how they work.

Spellcheck
When checking a document for spelling, the first consideration is what language to use. If you 
are in the United Kingdom, but your target audience or customers are in the United States, 
you should use American English, not British English.

1. Open System Preferences | International | Languages and check the box for US 
English. If it does not appear in the list, click on Edit List and add US English:
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2. If you are creating content—writing—for your project yourself, it's better to choose  
the language right at the beginning, to avoid having to make changes later. Click  
on the language icon at the top of the screen and choose your language from the 
drop-down menu.

3. Next, before using spellcheck, make sure that the document is linked to the correct 
language. For this, navigate to Inspector | Text | More | Language.

4. Click on the language drop-down menu in Text Inspector and choose the language. 
Your Mac will automatically use the preinstalled dictionary of that language for 
proofing and spellchecking. Remember, you need to select all text for checking, 
before changing the language.

When we run the spellcheck, it will find British spellings, such as "labour" for "labor" 
or "colour" for "color". But there are many less widely known differences in spelling, 
punctuation, and word usage between different versions of English.

5. To start spellchecking, open the Spelling window by navigating to Edit | Spelling | 
Spelling....

The upper section of the window shows the word that spellchecker is querying and 
the lower section of the window shows suggestions. Double-click on the correct word 
and the queried word will change accordingly in the document.

6. Click on Find Next, and go through the whole document, correcting spelling.

If you are sure that the word spellchecker is querying is correct—if, for example, it's 
a name you know—click on Ignore. If it is a special term or name that is not in the 
dictionary, but which you use frequently, click on Learn to add it to your dictionary so 
that it won't be queried in future.
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Proofing
iWork's Proofreader, like spellcheck, can be set to show mistakes as we type. You can navigate to 
Edit | Proofreading | Proofread as You Type or Edit | Spelling | Check Spelling as You Type.

Proofing is different from checking spelling. It picks up more complex errors and suggests 
changes. These include spacing before and after dashes, punctuation, and duplicated or 
complex words where there is a simpler way of saying what we want to say. It points out jargon 
and abbreviations, which may need to be explained.

1. To proofread, open the Proofreading window by navigating to Edit | Proofreading | 
Proofreader...:

2. If you agree with the suggested alternative, click on it and click on Correct.

Proofreading is a more subtle operation than spellchecking. Unless you have no choice but 
to proof your own work, you may find it is easier just to run spellcheck and leave proofing to a 
professional editor or proofreader.

Comments
Though they are powerful tools, neither spellcheck nor Proofreader will catch mistakes where 
a word is mistyped but is still in the dictionary. For example, "form" instead of "from".

This is why human editing and proofing is necessary. In situations where the editor/
proofreader must get approval for their changes by the project coordinator, comments are a 
good way to highlight where corrections may be necessary.
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In iWork, they look like yellow stickies in the side panel of the document. Each sticky has a 
thin line indicating the point in the document where the query applies. This point is called the 
anchor—it can be a word, a phrase, a paragraph, box, or even a graphic object.

1. Position the cursor where you want to place the anchor and insert a comment.

2. To insert a comment, click on the icon in the toolbar, or navigate to Insert |  
Comment menu.

3. When the yellow sticky appears, it already has highlighted text with your name and 
the date. Type your comment as you would in a Text Box. If you are the one who 
makes the final corrections, read the comment, make any changes, and then click on 
the cross in the sticky to close and delete it.

4. The document can be viewed without comments. Under View, choose Hide 
Comments. You can find this option under both the View menu at the top of the 
screen and the View drop-down menu in the toolbar.

Tracking
Besides Comments, iWork has an editing tool called Tracking. Tracking is different from 
comments in that it highlights changes that have already been made in the document and 
shows them with the option of accepting or rejecting them.

1. To activate Tracking, navigate to Edit | Turn Tracking On.

When Tracking is on, each new change is indicated by a blue sticky-style bubble in 
the document's side panel.

Inside the blue sticky, Tracking shows the name of the person who has made the 
changes. The name corresponds to the name of the account used on the Mac. If 
several people work on the same machine, make sure that they log in to their own 
account, if you need a record of who has made which changes:
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Blue stickies also show exactly what has been changed—text deleted or added, 
formatting added or changed.

2. When the project coordinator or chief editor goes through the changes, he/she can 
click on the check mark inside the sticky to accept the changes, or on the cross to 
reject them. After the change is accepted or rejected, the blue sticky closes.

3. When Tracking is on, a new toolbar appears at the top of the document. The Markup 
View icon on the right of the toolbar opens a drop-down menu with viewing options. 

When Show Text Markup is on, we can see the changes highlighted in blue.

If Hide Text Markup is selected, we only see the result, without the changes 
highlighted.

If Show Deleted Text is selected, it appears in the document highlighted and with a 
strikethrough—a line going through the text as though it's been crossed out.

4. On the left, the Tracking On and Paused buttons can switch Tracking on and off 
temporarily. These buttons are useful if, for example, you are the author and want to 
rework your project without your own changes being shown at every step of the way.

5. Once editing is finished, switch off Tracking and save the document. To switch it off, 
go to Edit | Turn Off Tracking or click on the action wheel on the right of the Tracking 
toolbar and choose Turn Off Tracking.

Find
The Find function is one of the quickest and most efficient editing tools.

Type Command + F to open the Find window.
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For example, if you want to change the spelling of a name throughout the document, type the 
current spelling in the top window and then type the corrected spelling in the bottom window. 
Then click on Replace All. Use this function carefully, or you could replace something you 
don't want to.

With Find, we can, for example, change shorter en-dashes to longer em-dashes, if it is 
required by the house style. Type the short dash in the top window and the long dash in 
the bottom window. Then click on Replace All. Invisible formatting can be changed too. For 
instance, double spacing can be changed to single spacing after each sentence.

There's more...
Even when everything is grammatically correct, text in different documents may vary 
significantly, depending on house or company style.

House styles include the use of different ways of capitalization, using different styles of quote 
marks, dashes, spaces, paragraphs, units of measure, and italics for foreign words and titles 
of books, magazines, and newspapers. Some companies may use only long dashes, others 
may use only short ones. Some publications put names of publications in quotes, others put 
them in italics.

For your document to look tidy and authoritative, choose a style and follow it consistently 
throughout. In the USA, one of the most authoritative guides is the The Associated  
Press Stylebook.

Editing, checking spelling, and proofreading your documents is very important. Sloppy writing, 
spelling mistakes, and typos can destroy the impact of your document. Why would readers or 
potential clients trust someone who doesn't bother to ensure the quality of their presentation? 
You may find that economizing on editors/proofreaders can cost your business more in lost 
customers.
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Apart from checking the writing itself, it is also vital to double- or triple-check the following:

 f Personal names

 f Brand names and titles

 f Place names

 f Addresses

 f Internet addresses (URLs)

 f Telephone numbers

 f E-mail addresses

Unless you have an editor who can come to your office to work on a document, you are likely 
to be working via the Internet in different locations, sometimes on other sides of the world.

iWork documents in current Mac OS versions can be emailed. If your proofreader doesn't 
have iWork, you can convert your project to a corresponding format, for example, DOC or XSL. 
However, some formatting may change, so if the formatting is important for proofing, convert 
iWork documents to PDF and let proofreaders check them with PDF tools.

If your iWork document is too large to e-mail it, you can use Internet uploading services such 
as Google Documents or similar ones.

See Also
 f The Using Command + F to search long documents when editing recipe in Chapter 1, 

Lateral Thinking

Working with designers—spread your 
workload and learn to assemble from 
different elements

When working on a large project it isn't necessary—and sometimes it's not possible—to do 
everything ourselves. It is much easier to achieve the best results by breaking our project 
into chunks of work that can be done by several different co-workers, using their own favorite 
software but delivering to us in PDF (or another iWork-compatible format). Then, it's up to us 
to put the modules together in an iWork document.

Modules might be small graphic files, for example, section headers or large semi-finished 
elements of a page.
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If these modules are graphics-heavy and too big to send as attachments, there are various 
free File Transfer Protocol (FTP) systems that you could use—Google, Skype, YouSendIt,  
and others.

How to do it...
This recipe is discussed in the following sections.

Slotting elements into an iWork document
One of our colleagues lays out several graphics-heavy pages for the magazine in  
InDesign, converts them to press-ready PDFs, and sends them to us. They are not  
whole, ready-to-go pages, only the part inside the margins. In iWork, we add headers,  
footers with page numbers, the publication title, and issue number. Then, we process the 
document from iWork to press-ready PDFs.

It can be done the other way round. We can design a page or a page element, convert it to 
press-ready PDF, and send it to a co-worker who puts together the whole project in another 
application, for example, InDesign or Quark.

The information that is needed to achieve this is as follows:

 f The page dimensions (inside the layout margins).

 f The width and height of columns and gutters (the space between the columns).

 f The position of repeated elements, for example, section headers or bylines  
with graphics. The position of these elements is shown in the Metrics Inspector  
as co-ordinates. Exact dimensions of graphic elements are also shown here.

Smaller design elements
Let's say we work with a graphic designer who is a hundred miles away. We meet occasionally 
for brain-storming sessions or to socialize. He/she designs some more complex graphic 
elements and advertisements in InDesign and Illustrator, but we put them in our layout as 
graphic objects in PDF format.

In the following screenshot, the Editor's blog heading is a graphic object, which is designed in 
Illustrator and sent to us in PDF. It was placed on an iWork Page as a floating object. The color 
panel on the left is also designed separately, in Illustrator. In iWork, we then added a Text Box 
on top of it and typed in our own text in white.
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This is how the elements of the page are assembled in iWork:
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Swapping color information for consistency
To work like this means that we need to make sure we have consistent colors—for branding 
and styling—and an overall tidy, professional look.
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To achieve full cohesion in colors, swap CMYK readings:

1. Open the Colors Viewer. Click on the rainbow-colored wheel in the toolbar, or click on 
the colors bar in Text Inspector, Graphic Inspector, or Chart Inspector.

2. In the Colors Viewer, click on the second icon with sliders, and from the drop-down 
menu, choose CMYK Sliders.

This shows you the professional print-shop breakdown of the color, which appears on your 
computer screen in WYSYWIG (what you see is what you get) mode. Read it out to your 
working partner, write it down, or e-mail a screenshot (press Command + Shift + 4, drag the 
crosshair cursor over the Color Inspector panel, and get a PNG file).

Using this information, our co-workers can recreate our brand color in any program—not  
just iWork.

If we create a partial design or layout for a co-worker or a client, we can use this method to 
copy colors—in an advertisement, which uses distinct brand colors, for example.

See also
 f The Making a good PDF from an iWork document, and CMYK PDFs for professional 

printing recipe in Chapter 3, Working Across Platforms and Applications

Sending out, uploading, and publishing 
iWork documents—ways to stay connected

When you work on a project that involves journalists, editors, photographers, graphic 
designers, and printers spread over a large area, you need to develop a variety of techniques 
to share documents and move them from one co-worker to another. The progress of the 
project has to be tracked in an office or from home.

How to do it...
This recipe describes a few common ways of sharing iWork documents.

Mailing
The current Mac Mail application allows you to send iWork documents as attachments.  
Open a new mail message and attach an iWork document as you'd do with a document  
in any other format.
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Documents can be compressed to reduce their size:

1. Click on the document's icon on the desktop or in a folder to select it.

2. In Finder, under the File menu, choose Compress.

Several documents or a folder can be compressed. After compression, we get a new file with 
the .zip extension. If one document is compressed, the ZIP file has its name. If several 
documents are compressed, the file will be called Archive.zip. If you want to change this 
name, click on the file name under its icon once to highlight it, and type in the new name.

When we double-click on the compressed package, it turns into an ordinary folder with the 
same name as the ZIP archive and contains copies of the documents, which also bear the 
same name as the originals. Either rename the documents now to avoid confusion later, or 
remember to keep track of which copy is which in case a document bearing the same name 
as the original comes back altered.

File transfer and storage services
Graphics-heavy, multi-page documents can be too large for sending via e-mail. In this case, 
there are numerous file transfer and storage (file sharing) services.

Apple has its own subscription service called iDisk. With the introduction of iCloud, the way 
the service operates is rapidly developing with parts of it becoming free of charge. Follow the 
latest news via Apple's website.

If you have an account with Google, iWork documents can be uploaded to Google Documents for 
sharing with co-workers. Follow the instructions, remembering to check the Notify by email box.

Or you can send documents using FTP services, such as Skype, YouSendIt, CyberDuck,  
or Zipper. 

Small networks (LAN)
For home-based or small businesses that use several computers, creating a local area 
network (LAN) can be the best option. You can swap files over AirPort or Bluetooth, or connect 
your machines with ethernet cables.

To connect two computers with an ethernet cable:

1. Plug the cable into the ethernet sockets on both computers.

The hard disks on the computers should have different names, not simply Macintosh 
HD, otherwise we won't know which one is which.

2. Open System Preferences and click on Sharing.

3. In Finder, choose Go | Connect to Server (Command + K).

4. In the dialog window, click on Browse, and when the second computer icon is shown, 
double-click on it. You may have to enter your account password.
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You can also use a router to create a local network. Connect the ethernet cables to the router 
box. After you've gone through the Connect to Server command, other computers will 
show on your desktop as separate hard disk icons. Double-click on them to access the other 
machines and move files between them.

Note that when you move iWork documents from one computer to another, a copy is created. 
Make sure that you track the copies as your work progresses, otherwise it is easy to get into 
a muddle. Mark versions of your project as 1st Draft, 2nd Draft, 1st Proof, Customer Proof, 
Final, and so on.

If you are not confident about setting up a local network, ask a 
computer service to set it up for you and draw up a list of simple, 
easy instructions to follow. Avoid going into areas where you might 
mess up settings.
When your computers are connected to a small network, drag the 
icons of the other machines onto the Dock. Next time you connect 
to a co-worker's Mac, you will only have to click once on their icon 
to connect.
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Putting folders and files in the side panel
During an ongoing project, create folders for each stage of the work. One 
folder, for example, Magazine 1st Draft, can be on the designer's Mac. The 
second, Magazine 2nd Draft, on the editor's computer.
When you are on a LAN, you can move the icons of folders located on a 
different computer to the side panel of a folder window on your computer. 
Then, when you click on an icon in the side panel, the folder opens—even 
if it is on another computer. Open the document without moving it to your 
computer—this avoids creating multiple copies.

Using PDFs
PDFs can be opened on any computer and can be sent via e-mail or FTP. PDF applications 
have commenting and other proofing and editing features.

Using modules
Break your iWork project into chunks of work that can be done by many different workers 
using their own favorite software, other than iWork.

When they create their own part of the project, for example, a graphic element, they will 
deliver it to you in PDF or another iWork-compatible format. Then it's up to you to put the 
modules together in an iWork document.

Modules might be small graphic files, section headers, or large semi-finished elements  
of a page.

Converting files from Pages to Word and Word to Pages
If your co-workers don't have iWork, use the Share menu to export to DOC or another format. 
Some formatting may be lost, but not to the extent that the document becomes unrecognizable.

Screenshots
To make a screenshot, follow the ensuing steps:

1. Type Command + Shift + 4.

2. The cursor turns into crosshairs. Drag it over the area of your screen that you want to 
capture and let go. You get a compact PNG file.

This feature is very useful when you are sharing or working in a team—to send out proofs, to 
illustrate an aspect or a detail of design that is too long to describe in words, and so on.

Make a screenshot of the contents of a folder to share lists of files.



Building a Team and Working from Different Localities

16

You can send detailed technical information about a document with a screenshot of the  
iWork Inspector, for example, with the CMYK reading of a color or co-ordinates of an object  
on the page.

See also
 f The Dragging a Word file onto the Pages icon to open it recipe in Chapter 3, Working 

Across Platforms and Applications

 f The Fitting files of other formats into iWork documents recipe in Chapter 3, Working 
Across Platforms and Applications


